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Introduction
Congratulations on purchasing Pixel Dungeon Dojo! And, thank you.

This tutorial project is a framework for an infinite number of dungeon levels, with puzzles, traps and 
monsters, exploration, hazards and treasure.

The level designer is YOU.

A Dojo is traditionally known as a place to learn and practice, and the Pixel Dungeon Dojo is a place to 
practice level design. This guidebook is here to present the Dojo to you, in a way that anyone can use 
this framework to build their own dungeon-crawling game levels and see those levels and your name in 
the credits of a casual 2D game.

Your name in the credits, your dungeon levels in the game.

Those already familiar with level design or familiar working with Unity will find the Pixel Dungeon Dojo 
makes level design a quick and cozy experience, allowing you to focus on level design practices and to 
freely explore new designs in architecture, combat design and game story.

Cozy and fun and cool and easy, for both beginners and seasoned level designers.

In Pixel Dungeon Dojo, we are free to practice the way and to design levels your players will love.
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Overview
Pixel Dungeon Dojo is a tutorial project in Unity, showing a relatively casual 2D top-down pixel art 
dungeon-crawling game with puzzles, traps and monsters. But the real value in Pixel Dungeon Dojo is 
that it is a framework, a platform specifically for designing levels of this game.

The game menu system will reflect the levels you build, including your name in the credits as the author
of those dungeon levels. You have the power with Pixel Dungeon Dojo to create dungeons of your own, 
with as many levels in those dungeons as you like.

Making a new dungeon is as easy as making a folder.

Making a new level starts with a template scene you “Save As...” and place in your dungeon folder, 
naming this scene appropriately for the game system:

.../Scenes/[Your Dungeon Name]/[Your Level Name]-[Your Name].unity

Then, take the tools in the framework: the art tiles, the music selection, the level pieces for items and 
characters, etc.; and use the tips that guide you from this guidebook to begin building. You take a few 
steps building your level, snapping tiles into place, placing a some items, and then you play test from 
the Dojo Menu scene.

Tip: Players are able to play Pixel Dungeon Dojo either with keyboard and mouse, or with a 
standard game pad.

To play test is not really about playing the level yet, but you do get to see what your players will see just 
by hitting the play button. You find things that work well, things that could be better, and you stop and 
go back to make adjustments, additions and enhancements to your level design.

If you just need a sword or a health potion while testing your level, just hit the pause button and drag it 
in while the editor is playing. No worries, this won't change your level design. When you stop play 
testing, any changes you made during runtime will be un-done.

Place some more tiles, a few more items, configure a door to open with a key, set monsters in place 
here and there, put treasure over there, etc. Then, pause and play test again to see how it's improving.

Design is making things better.

Tip: Review the provided dungeon levels, see how these were put together as an example, and 
find Dojo Gizmo Tip objects that point out features to focus on.

The Pixel Dungeon Dojo just takes the more time-consuming and technical issues out of the way, with 
tools that are helpful, simple and do what you need just by dragging it from the Prefabs folder, placing 
it into your level scene, and configuring it.

Pixel Dungeon Dojo is cozy Level Design.

We encourage you to share your level creations with friends to play for free, just by building the game 
and from the Unity editor and sharing it with them. We also encourage sharing level designs with friends
who have their own copy of Pixel Dungeon Dojo, by exporting your dungeon folder as a tiny package file.

Design. Create. Build. Play. Share.
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Beginner's Quick Start
To take your first steps, and learn how Pixel Dungeon Dojo is used to make your own levels. If you've 
already got the Pixel Dungeon Dojo package installed in a project, you could start by playing the game.

First, make sure the Dojo Menu scene and Simple Dungeon Level scene are in the Unity project build 
settings, and with the Dojo Menu scene open, hit Play.

To configure the Scene List in the Unity project:

1. “File” → “Build Profiles...”

2. In the top left corner of the pop-up window, click on Scene List.

3. In the Project panel, find the Scenes folder and open the Release sub-folder inside.

4. You should see both “Dojo Menu” and “Simple Dungeon Level” there, drag and drop each of 
those into the box labeled Scene List.

5. You should see these two levels in the build profiles Scene List now. So, you can play.

These steps allow you to play, see the game system in action, and experience what the player does.

You now know how to put your own levels in the game, because placing your level into the Scene List 
will do it. The game will recognize your dungeon folder if it is inside any folder called, “Scenes”, and 
your level uses the naming convention, “[Level Name]-[Your Name]”. If so, the menu shows the player a 
button for your dungeon, and your name in the credits just like the other dungeon levels.

Pixel Dungeon Dojo Level Design Guidebook Version 1.0 July 2026



8

You may have noticed there is a sample dungeon available in the Scenes folder, with seven levels. After 
you've played the simple dungeon level, go ahead and open the Scene List again, and drag in all seven 
levels of the Sample Dungeon one-by-one, in order. Now, hit Play again and notice this dungeon is now 
available in the Explore Dungeons menu, and the credits are updated to display the new dungeon levels 
as well. The order of the dungeon levels in the Scene List is the order they player will experience them.

This is how you can add your own dungeons and levels. But, maybe play a little more from the Dojo  
Menu scene, to see what the Pixel Dungeon Dojo gives you to work with as a level designer.

Tip: Being a player is an important part of being a good designer. Maintain a balance between 
what you work on in level design, and checking in to see what the player experience is shaping 
up to be; by being the player again and being honest with yourself about the results. This is the 
way to help improve your designs.
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Your First Dungeon
Let's get down to the practice of level design, and using Pixel Dungeon Dojo to make this easy.

Create a Unity Project
Begin with a simple, yet optimized, 3D Built-In Render Pipeline project. Go to “File” → “New Project …”, 
and select the template for “3D (Built-In Render Pipeline)”. You may need to download this template if 
you have not yet done so. Consider naming this new project something like, “First Dungeon Levels”, for 
convenience.

It may seem counter-intuitive to use a 3D project for a 2D game, but to put it bluntly, all Unity games are
3D. The difference you'll find is just the way the camera uses the space, and limits the Z axis to a depth 
the player will never see. Rather than using the new standard of a Universal Render Pipeline, you'll find 
that the 3D Built-In Render Pipeline project is created quickly, loads fast, is a smaller size and builds an 
efficient game. Pixel Dungeon Dojo is made to take advantage of this type of project, even if any render 
pipeline can be used.

Tip: Remember to take advantage of the pause button in Unity while play testing in the editor. 
Although any changes made while in pause are lost when the game is stopped, you have the 
opportunity to look at any object in the scene, all the detail configurations, and analyze anything
happening in your level.

Install Pixel Dungeon Dojo
The package you've purchased is always available to install in any project you make. Just open 
“Window” → “Package Management” → “Package Manager...” to find your copy of “Pixel Dungeon 
Dojo” to select it. Once selected the “Install” button will place everything in this new project.

This framework gives you a menu called, “Tools”, with one button in it called, “Dojo Editor Settings”. 
This one button will do two things behind the scenes: configure your project for making a proper game 
build, and configure the Scene panel view for working in 2D. Easy.

Set a Unity Layout for Dojo Level Design
The Project panel in Unity is going to help you make your own levels. The Hierarchy panel is going to 
show you what is in your level, and how these pieces are organized. The Inspector panel is going to show
you what each piece is configured to do, with helpful property naming and tool tips along the way to 
make clear how your settings are going to work in the game.
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It is recommended you use a layout that clearly displays all three of these panels at once, along with the 
Game panel and the Scene panel. A layout configured for working in the Dojo is provided in a file found 
in the folder “Scripts/Editor/Layout, called “DojoLayout”. It's a “2 by 3” layout, modified to make sure 
the Project panel appears plainly as the Assets folder of your project. Go to “Window” → “Layouts” → 
“Load Layout from File...”, and use the “.../Scripts/Editor/Layout/DojoLayout.wlt” file.

Make the Dungeon Folder
In the Project panel, in any folder called, “Scenes”, right-click and create a new folder. The folder name 
will be the name of your dungeon, so you'll want to think of a good name for the dungeon, and for your 
levels. (you can always start with “My Dungeon”, for this first one.

Make the Level Scene
Open the template scene found next to Dojo Menu and Simple Dungeon Level in the Release folder.

Use the menu at the top, “File” → “Save As...”, to save your new level with a particular name. The 
level's name, like the dungeon name, will be shown to the player, so you'll want to give it some thought.
But also, you will need to include a hyphen between the level name and your name on this scene file.

“My New Level-My Name”

This format of your level name will make sure the game understands this is a Dojo level, that should be 
treated like any other level in the game, with the ability to play, show high scores and display your 
name in the credits, as the author and level designer of the dungeon.

Remember to place your new level in this project's Build Profiles Scene List. See the Beginner's Quick 
Start above for a step-by-step guide.

Open the Area Folder in the new level
If you've used the template scene, your new level is ready to play immediately, even if it is blank. But, 
hidden in this scene are helpful tools that make this easier for you. The first and most important tool is 
the folder organization.
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There is a prefab folder you can drag and drop into your Hierarchy panel to make new areas of your 
level, and stay organized. The folder is collapsed, and opens to show sub-folders in the scene, for 
Structure and NPCs and Props, etc. One of these is already in the template scene, so you should see it 
now; it's ready to be re-named as the name of your first area in your new dungeon level.

Name this folder in a way that helps you remember what this area of your level design is; ex.“Entry”.

Drag and Drop a Floor for a Room
The Project panel Prefabs folder has sub-folders for all the items you need to make your level designs, 
and we can focus on architecture now, starting with the floors. While we wouldn't want our dungeon to 
only have a floor, we can imagine the walls and other elements there and make quicker adjustments to 
the room size, its shape and potential entrances and exits.

Tip: Consider working in a methodical way; using a method, a process. Finding a way that works 
best for you is part of the improvement a designer does. By finding more efficient and effective 
methods, the designer has more time and focus to spend on making things better for the player 
experience.

Open the Structures sub-folder in Prefabs, and open the Floors sub-folder there. Drag and drop this 
prefab into the Scene panel or Hierarchy panel (either way will add it to your level), and use the 
translation gizmo to move it. There is a button with four arrows to translate, and the hot key is “W”.

You'll notice the floor tile 'snaps' along the grid as you move it, and it will always set on the grid. There 
is a tool on each tile piece and most level elements that help you keep items on the grid, called the Dojo 
Tile Snap.

Size and Scale with Dojo Tile Snap
Look over at the Inspector panel and see the Dojo Tile Snap component. Use this tile snap to scale this 
floor tile, instead of trying to scale it (the tool will also lock in place rotation and scale). The tile snap tool
is consistent among the Pixel Dungeon Dojo elements, so you can become more efficient with it. By 
scaling the size in X and Y with Dojo Tile Snap, the tool is also automatically scaling collision and other 
elements associated with this tile. This is one of the primary ways the Dojo helps make level design 
easier and quite cozy to work with.

If you begin to work with these tiles and find an odd tile scale or position means the snap is out of place 
when putting two pieces together, use the Dojo Tile Snap settings for Precision to adjust from snapping 
to the Whole grid, to Half or Quarter. (no problem)
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The Dojo Tile Snap also means you may work quickly and know that the snap will be there to help.

Make a Hallway and Another Room with Floors
Drag in new floor tiles, move them in place, scale them and allow tile snap to help. Get a feel for how 
this will work for you. Note that your folder is there to accept each new tile as you drag it into the scene.
The area folder you've named has a sub-folder for Structure to keep everything organized.

It may seem unnecessary now, with only three tile pieces, but levels often have many pieces and 
staying organized along the way helps save time when you need to make adjustments and find things 
you want to work with.

Get in the Habit of Saving and then Play Testing
(for science, of course) You should also have a routine of taking breaks periodically.

Tip: Go ahead and set a timer for some interval that feels comfortable for you, maybe 15 
minutes. When it goes off, save, reset the timer, and decide to either play test and/or take a 
break. Keep resetting the timer just to keep track. This is a productivity technique known as 
“time boxing”; and helps you stay balanced and efficient simply by being more aware of the time
passing.

Place Corners of Walls First
This suggested method may not be obvious, but try it. In the Prefabs folder, under Walls, find a Corner 
tile and drag it in.

Note that the corner wall, like all walls, include shadow meant to suggest the outside of the playable 
level. The corner can be used to sit just outside the floor area you've made, a block set off the floor to be
a corner the player cannot move through.

If you drag in four of these corners, you can place them on corners of the first room floor and rotate 
them. The rotation gizmo is a button next to translation, and the hot key is E. Notice that Dojo Tile Snap 
will help keep this rotated at 90 degree intervals. If you learn the four orientation numbers: 0, 90, 180 
and 270, you can enter these in the Inspector panel on your selection, under the Transform 
component's rotation in Z.

You might play test to see how pieces line up, and to ensure the room appears as you want for your 
player. If not, it's easy to change this, due to the small number of tiles and the helpful tile snap tool.

Configure Inner Corners
Not every corner is the same. Aside from rotating the tile, sometimes the shadow should be facing 
outwards but cannot. An “inner corner” is one that simply needs the shadow to move out, and we see 
those often in corners leading into hallways from rooms.
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To make a normal corner tile shadow appear correctly, you can use the component Dojo Corner Shadow
to set the shadow from the default “Outer” to “Inner” (or “None” when you have a wall within a room).

Entrances and Exits

Levels can have pleasing ways the player enters or exits, like the stone stairs available in the Prefabs 
folder. Within Structures, you'll find Stairs, and you may select Stairs Down or Stairs Up. Place a stairs up
leading into your room, as if the player came down the stairs to enter. By default, up stairs are 
configured to allow the player to exit the dungeon, as if they've retreated and gone home. Down stairs 
are configured to win the level by default. Stairs can be configured to lead to another level by its name. 
These configurations are available in the Inspector panel while the stairs tile is selected.

You might play test, just because it's fun, but also to stay focused on what the player experiences.

Place Walls
Finally, we can fill in those gaps between corners. In the Prefabs → Structures folder, find a wall prefab 
and drag it in. By now you know the tile snap is helping to place and scale this piece, that shadows are 
on your wall, and you can rotate the wall to make it appear correctly. If there should be no shadow, 
open it and turn off the shadow. Remember you have the folder organization for this first area as well.

If you see tiles that don't line up, you may need to revise the scale of the floor, move the corners and try
again. The tile snap tools make revisions easy.

Place Items and Treasure
In the Prefabs folder, you'll find Props next to Structures. Within Props, you'll see lots of different items 
you can drag and drop into your new level area. Try placing a few pieces of treasure, a sword or two, 
and maybe a potion.

Tip: All players like to discover loot, and consider that when you strive to  balance what they find 
with the dangers you present to them, the player will feel the level design is 'fair'.
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Place Monsters
Time to think about how the player might be challenged. One of the primary ways this game challenges 
the player is through the simple combat system, and placing NPC enemies in your level is the most basic 
way to conduct combat design.

The number of enemies, their placement around the player, the way they approach, their delay or 
timing, all change the combat experience for the player. It is a very deep subject to explore. For now, 
place a few enemies.

Tip: Consider that the level design works within the game they design for. In that way, think of 
the fact that, in this game, a sword is consumed when an enemy is hit. You can therefore 'match'
enemies with swords for a fundamental balance in combat design in your Dojo Dungeon levels.

The only way to confirm your combat design is working, has balance, is a challenge, etc. is to play test.

Tip: A powerful pattern to use in your practice is one taken from professionals. Level designers 
will show players something new, then again with an option to interact with it, then the player is
tested with it before they can move on, and finally, the level designer is free to combine this 
new element with others and in creative ways, confident the player educated on it. This pattern 
of “Introduce, option, test and evolve”, allows you to organize how items, NPCs and elements 
are placed and sequenced so that players experience new things, feel smart and are challenged.

Place a Door and a Key
Let's try one of the many dynamics you can put in your levels: a door that is locked.

Within the Prefabs → Structures folder, you'll find Dynamics, where a Door prefab is available. Place this
closed door in the hallway you made and rotate as needed. While it is selected, you can see the settings 
in the Inspector panel. Note that a door can require a Key to open, set this to “Gold”.

Of course, we'll need to provide the player with a gold key before they get to the door, so in Prefabs → 
Props, find the Key Gold prefab item, and place it.

Tip: When a player comes to a locked door, the game will provide a hint as to what color of key 
is needed. So, as the Level Designer, you can rely on this notice to the player and 'hide' the key a 
little more, knowing the player will be on the hunt for it.

Beginning, Middle and End
While there is a lot to explore in the field of Level Design, this first level should be shaping up. And, this 
step-by-step process should help show you where to look for pieces, configurations and ideas.

Tip: The Sample Dungeon and Simple Dungeon Level are available with examples of various level
design elements to work with. If you see something you like, find it in the editor and see how it is
configured. And, remember to experiment with elements you haven't tried yet, and to always 
play test. Have fun!
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Dojo Dungeon Pieces
The following is just some of the Level Design elements provided in Pixel Dungeon Dojo, the ones to 
become familiar with at first. There are other prefab elements available, and some are used exclusively 
by the game system rather than being tools for your level designs. However, in the Component menu 
under “HIPTools” → “Pixel Dungeon”, there are multiple 'loose' tools available to use freely as you begin
experimenting to grow and expand your Level Design skill set.

Level Area Folder
This is the main prefab to begin a new level area with; “LEVEL AREA (Unpack & Rename)”, is found by 
itself in the main Prefabs folder for that reason. To start a new area, drag and drop this folder into your 
Hierarchy panel, then right-click to find the menu item “Prefab >”. From there you'll find “Unpack”. This 
operation disconnects it from the original prefab in the project (for safety) and you can then freely 
rename this folder to be your new level area. (example: “Room 1”, or “Grand Hall”, or “Factory Floor”)

Use naming and organization patterns that work best for you, and then stay consistent with them.

Tip: Your level benefits from good organization, and so do you. While you begin to make larger 
or more complex levels, the amount of game objects in your Hierarchy panel will grow to a very 
long list. By making a habit of taking the prefab you just added from the Project panel, and 
immediately dragging and dropping it into an organized folder location, you're able to find what 
you need when you need it.

Character NPCs
Non-player character monsters in Pixel Dungeon Dojo.

Skeleton

Move: 3 Health: 1 Loot: No

Damage: Physical Attack Pattern: None

This character moves slower than the player, and takes one hit before defeated.

Boss

Move: 2 Health: 3 Loot: Yes

Damage: Physical Attack Pattern: None

This character moves slower than the Skeleton, and can take more than one hit before defeated. 
(Default is 3 hits) This character, and all other Boss characters, can be configured to drop an item as loot 
once defeated.
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Fire Boss

Move: 2 Health: 7 Loot: Yes

Damage: Fire Attack Pattern: Yes, with Projectile Fire x3

This character moves as slow as a Boss, has a default health of 7, can drop loot, and attacks the player in
a pattern. During the pattern of attack, this character launches a projectile made of fire that explodes 
when it lands. This projectiles explosion causes an area of effect that damages in a radius around the 
impact point. This character is immune to fire damage.

Boss Attack Patterns

Boss patterns will vary, but will cycle to repeat the behavior. Including a pause and a charge toward the 
player and an attack of some kind. Bosses will perform this attack pattern when the player is within 
range to be noticed by the boss.

Ice Boss

Move: 2 Health: 7 Loot: Yes

Damage: Frost Attack Pattern: Yes, with Projectile Frost x3

This character moves as slow as a Boss, has a default health of 7, can drop loot, and attacks the player in
a pattern. During the pattern of attack, this character launches a projectile made of frost that explodes 
when it lands. This projectiles explosion causes an area of effect that damages in a radius around the 
impact point. This character is immune to frost damage.

Ghost Boss

Move: 2 (4 in 'ghost') Health: 10 Loot: Yes

Damage: Magical Attack Pattern: Yes, with Ghost and Shout

This character moves as slow as a Boss until they perform the attack pattern, where they can become 
ethereal and 'ghostly' and travel as fast as a common Skeleton, moving through walls and hazards. This 
character has a default health of 10, can drop loot, and attacks the player in a pattern. Along with the 
'ghost charge' behavior the attack pattern includes a shout; a large area of effect that causes one or 
more attacks to any within range. While in 'ghost charge' this character is immune to all damage.
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Level Elements
The following level elements are used as part of an array of trigger system components, where one 
element can activate or trigger another, and so on. For more, see the section “Getting Started with 
Trigger Systems”.

Check Point

This element detects the player and causes the player respawn location to change. Once the player 
reaches another Check Point, the respawn location is changed again, and there is no inherit order to 
these; the player may back track or reach a Check Point in any order. By default, a level's entry point is 
the initial respawn location.

Dynamic Activator

This is a powerful element able to activate or trigger more than one other element, and it can itself be 
triggered by activation, collision or with a timer. This can also be configured to repeat the triggering of 
other elements.

Story Scroll

By default, this appears as a scroll item the player can pick up. As they do, a 
HUD pop-up appears to present a small piece of story text, with a title and 
the ability to close the pop-up. By default, the text will appear word-by-
word, but the player always has the option to skip that operation to display 
the text all at once. This can also be configured to only display all at once. 
This has the option to be picked up only once, or to be automatically 
dropped and left behind, able to repeatedly be picked up again. Text that is 
configured can include the character sequence, “\n”, to cause the text to 
include a new line.

Tip: Test story text to ensure the text is not too long, has no spelling errors, appears the way you 
want it to, and is understandable to your players.

Timed Spawner

This element is made to wait a configured duration before spawning a prefab element at its location. It 
may be configured to repeat this spawn action, and it can be configured to limit the total number of 
spawned elements; where it will continue to respawn new elements if previous ones are destroyed. By 
default, a visual effect and sound effect will be presented at this location when the element is spawned.
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Prop Pickup Items
These are elements meant to be seen by the player as items to acquire and collect. Unlike the story 
scroll, these elements are either consumed upon pick up, or are otherwise collected as valuable score or
items to be held in inventory and used elsewhere.

Keys

Keys are made to open locked doors. Keys have a color that matches the door lock hint that a locked 
door will present to the player. The available color of keys are: Blue, Gray, Green, Gold, Purple, and Red.

Potions

Potions provide the player with effects that benefit them in some way, indicated by the color of the 
potion.  The available potions are: Health, Speed, Invulnerability, Fire Resistance, Frost Resistance and 
Ghost. Invulnerability means the player can take no damage from attacks. Fire or Frost Resistance 
means the player can take no damage from attacks of that damage type. Ghost means the player is able 
to move freely through walls, doors, NPCs and items; unable to pick up or effect the 'physical' world. 
However, if they wield a sword, they are able to attack NPCs with it, even while in the Ghost effect. If a 
player's Ghost effect ends while they are inside a solid item or structure, or are outside the level 
entirely, they will be reduced to zero health instantly, and respawn.

Potion Effects

The potion of healing takes immediate effect, while all other potions have a lasting effect with a 
duration of 15 seconds. Just before the effect wears off, the player avatar will flash to help the player 
understand this effect is about to end. Potion effects can be carried together.

Swords

The swords are the player's means of conducting combat. Swords appear as different metals, in 
different colors, indicating their relative strength or sword power. The varieties of swords, in order of 
sword power, are: Copper, Iron, Steel and Vorpal. All swords to physical damage, except the Vorpal 
sword, which is magical.
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Treasure

The treasure collected by a player translates into the points scored in the game, along with each hit on 
enemy NPCs. Each treasure element has a relative value for this score. The varieties of treasure, in 
order of value, are: Single coin, Double coin, Triple coin, Ring, Necklace, Scepter, Crown and Gem. There 
is a special treasure item, the Gem Win, that doubles as a level end trigger. Gems are able to be 
configured just as the Level Exit element.

Structure
These are tiles of architecture that provide the basis for level design, with all the visual and 'physical' 
elements to hold the player within the game level bounds and act as the setting the player finds 
themselves in.

Dynamics

These are special structural elements meant to change or provide a hazardous area in the level.

Door

This wooden door may be configured to be opened freely, or require a particular key by color, or require
a trigger signal from another element. The door can be configured as open initially, or to be changed 
only once.

Lava Pit

This is a hazardous area that immediately damages players, NPCs and dynamic props with fire damage.

Pit Fall

This is a hazardous area that will cause players, NPCs and dynamic props to fall endlessly and be 
removed. Players will then respawn.

Tip: While a lava pit will immediate hurt a character or dynamic prop on contact, the Pit Fall 
needs to appear the element has fallen, meaning it must be all the way off the edge of solid 
ground; otherwise it appears unfair to players. The Pit Fall collision is the touching point where 
falling begins, so set this smaller and away from the visual edge of the ground; one unit away. 
You can also add visual effect Lighting as shadow tiles to help the player understand this is a 
ledge to a pit fall hazard.

Pressure Plate

This is a space on the floor that accepts 'physical weight' from players, NPCs and dynamic props, where 
the result it the plate lowers to trigger other level elements. More than one element can be holding the 
plate down, but when no other valid elements are detected, it returns to a raised plate position and will 
un-trigger those elements it had effected. A pressure plate can be configured to trigger only once. It can 
be configured to repeat and toggle the other element it triggers.
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Wall Shooter

This element appears as a hole in a wall, with a metal frame around it. When triggered, this launches a 
magical bolt that damages players, NPCs and dynamic props.

Wall Switch

This is an element players will recognize as a way to trigger other things. It appears as a switch that can 
be in one position or another, and it moves as the player collides with this element. This element will 
trigger another element, and can be configured to trigger once only, or to repeat and toggle.

Floors

This is the basic tile element indicating solid ground the player, NPCs and dynamic props can be on.

Stairs

This element helps the player understand the start and end points of levels. The stairs up are 
configured by default to allow players to 'retreat' to the menu. The stairs down are configured to win 
the level and go to the menu. Stairs can also be configured to block the player entirely, or to win the 
dungeon, meaning that they will be presented an additional announcement for this achievement. To use
the stairs as a portal to the next level, configure the Level Name to match.

Walls

Various tile elements are provided to accommodate many level designs, including the shadows that 
help the wall to appear to be on the edge of the level outer bounds. To effectively use these tiles, make 
use of the Dojo Tile Snap component to scale them, and find the other components for Corner Shadow 
for details that simple rotation of the tile cannot accommodate. In cases where no shadow is desired on 
the tile, simply un-collapse the game object to find the shadow as a child object you can deactivate. The 
varieties of wall tiles include: Cap, Corner, Cross, T-Corner and Wall. If you find the position of the tile 
cannot match while snapping, use the snap component Precision property to switch from Whole to Half 
or Quarter unit precision.
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Visual Effects (VFX)
These are special tiles meant to provide the Level Designer with finer detail appearances.

Lighting Tiles

The lighting tiles include overlays that are meant to appear above the other structure tiles, and color 
them appropriately for the visual aesthetic desired. There are shadows, the same ones used by default 
on wall tiles, that appear as black or dark semi-transparent tone. There are also light tiles, designed to 
be used the same way, but then colored as desired by configuring its Sprite Renderer component. The 
varieties of Lighting tiles include: Corner, Full, Half and Invert. Full covers a rectangle you can position 
and scale as normal. Corner and Invert are available for detail edges. Half tiles appear as a gradient from 
the full color to transparent, allowing a subtle visual transition.
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Getting Started with Trigger Systems
Trigger systems allow our level to react to what the player is doing, in a way that makes the level 'come 
alive'. When you have trigger systems in your level, the switch can open a door, the pressure plate can 
activate a wall shooter, a steel sword spawns when the player reaches a particular location, etc.

A trigger system is more than one level element working together, connected by configuration and set 
up to perform some behavior when some condition is met. In other words, you make up a rule about 
what happens and how or when it happens, and a trigger system can be set up to make sure the level 
does exactly that.

Common Elements to Use
The elements players notice and use most often are the wall switch, pressure plate and door key. These 
are obvious visual elements that give the player the basic information that this element is made to 
trigger something else.

The more obvious elements that are reactions to triggers include the wall shooter, door and story scroll.
When one obvious element is connected to the other, the player learns how this trigger system works, 
and tries to play while using that.

More Trigger System Elements
Less obvious, but very powerful, trigger system elements include the check point, the timed spawner 
and the dynamic activator. Let's focus on these and learn more.

Check Point

A check point is a silent trigger that tells the game to respawn the player at that point. When placing a 
check point, care should be taken that the player cannot be stuck without the means to proceed if they
respawn there.

Timed Spawner

A timed spawner is available to spawn items or NPCs in that particular location, and at a time from the 
activation of the tool. That is, once something else triggers this spawner, a delay can be used before the 
item or NPC is spawn. Also, a timed spawner can be configured to only have a number of those spawned
elements in the level at any given time. And, the timed spawner may be configured to continuously 
respawn using that timed duration, and keeping them total number of spawned elements within range.

Dynamic Activator

A dynamic activator is the mother of all trigger system elements. It acts as the relay from signal to 
reaction, and can activate or trigger a number of different elements. The dynamic activator can be 
configured to be triggered on a timer, or by the player or other solid element collision with it, or by 
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another trigger system element activating it. And, the dynamic activator can be configured to trigger 
more than one element. It performs the role of trigger with lots of flexibility, and it performs the role of 
an event manager, able to effect multiple level elements at once.

Going Further with Trigger Systems
Very sophisticated trigger systems can be made using these modular elements, configured to work 
together.

Any trap will use a trigger system, of course, but consider that combat designs can also benefit from 
using trigger systems to make the combat situations more dynamic; as in timed waves of monsters, or 
an ambush attack of spawned NPCs when a player takes nice-looking treasure.

Puzzles are a classic challenge for game designers. Making a player performance difficult, but not too 
difficult to solve, is the challenge for the designer far more than for the player. The key components of a 
puzzle include things the player can plainly see, but do not have the idea or context to put them to use. 
Once the player does get the idea, they should feel smart; that's the mark of a successful puzzle.

Tip: A neat trick to puzzle design begins at the end. A solved puzzle, a satisfying result, can be 
imagined first, and then broken into pieces; pieces that would logically fit (or visually fit, or 
sequentially fit, etc.) but they are then scattered before the puzzle is needed to be solved. The 
pieces found by the player (such as a wall switch that appears to do nothing) will be an oddity 
that eventually will be left behind, if another is encountered, the first will be remembered, but 
without context, the player will leave that as well. Finally, at some result, like a series of doors, 
with treasure on the other side, the player will think about their options and have to consider the
wall switches as possibly connected. They will feel smart.

A trigger system used for a puzzle should be carefully planned first; even with paper and pencil, to 
make note of the details that matter to the logic of the puzzle, and to the satisfaction of the player.

Tip: Combining the ideas of puzzle, trap and monster in various ways can lead to creative level 
design ideas to surprise and delight your players. Perhaps a monster springs a trap, or a puzzle 
solution spawns a monster, or a trap needs to be sprung to solve a puzzle.

When working with trigger systems, and one element is triggering another according to a rule, you're 
working with rule systems, sets of rules working together. The rules are commonly known as game 
mechanics, as they work mechanically, as if made of metal machinery. And, the resulting systems you 
make are a form of systems design that is the basis for all games, and game dynamics.

Experimentation and testing, trial and error, evaluation and revision are the ways to grow as a systems 
designer, and you now know the way forward.
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Level Design Challenges
The following are suggested ways to challenge yourself as a Level Designer, once you've had a fair 
amount of experience working with Pixel Dungeon Dojo and sharing your levels with players to get their 
feedback.

Tip: It is important for all Designers to use the feedback they can get to help them make their 
designs better.

Push Me Pull Me
This is a challenge to the make level that plays well one direction, and can be played just as well going 
backwards from the 'end' back to the 'start'. The typical progression of challenge in a level design needs 
to be maintained even if the player is proceeding backwards. The designer's challenge is to make the 
level progress appropriately and somehow still surprise the player while going backwards; bonus if the 
same player can play the level in either order first, and still find both satisfying.

Spell It Out
Create a level design layout based on the shape of the letters that make up your initials. Bonus if the 
player cannot quite tell the shape spells letters until the end. Super bonus if you use the Dojo Camera 
Zoom tool to reveal the letters at the end, using a trigger system of some kind.

Headphones On
Create a level with the music trigger set to None, and use custom audio objects (game objects with 
Audio Source components) to highlight the level areas with sound. Source sounds you find (suggest 
Freesound.org) and consider triggering them with trigger systems rather than loop. Configure the audio 
objects more toward spacial blend of 3D sound and set their falloff to Linear, to make configuration 
easier. Bonus if the sounds you've selected are able to help players escape the level or solve a puzzle.

Frenzy
This is a combat design challenge to come as close to frustrating the player as possible through combat 
difficulty. Rather than overwhelm the player with enemies and no swords, your challenge is to very 
finely balance the two, and still make the combat achievable. Bonus if your player do not win 
immediately, but are eager to replay and try again, because they feel they can win.

Home Sweet Home
Create a dungeon level based on your home, a familiar layout, shape and contents, even if it looks like a 
2D dungeon. Feel free to be very accurate with your home measurements to help you, and sketch a 
floor plan to guide you. Bonus if a family member or friend can answer the question, “Does this level 
remind you of a particular place?”, when asked.
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Design Principles
This is a small collection of ideas to keep in mind as you consider ways to improve your designs. One 
might think of these like a lens you look through to see in ways you hadn't seen before, or to remind 
yourself of perspectives that will help generate ideas, refine details or satisfy more players.

Design = Art x Science
When we said, “Design is making things better”, we're summarizing a broad topic about how to 
approach design. It turns out, science does the same thing, through the scientific method. This is why 
we've been talking about testing so much. Art is of course also involved, because sometimes to find our 
way, we need the creativity to imagine anything. Design uses both Art and Science as multipliers. We 
gain a lot of insight and potential with the lens of Art, but we can verify things work and come closer to 
the needs of our player through Science. It's both. Design = Art x Science.

Design Tenets
These are basic ideas that all Design can utilize. These are broad concepts that apply to any kind of 
design and always help make things better.

• Variation

It can be any alteration from one point or one time or one idea, to another. When it's there, 
variation creates interest and demands some level of attention.

• Contrast

A form of variation that leverages an extreme, and again, can take many forms. Contrast keeps 
one extreme cleanly separated from others, and produces clarity.

• Rhythm

A repetition with some amount of predictability, perhaps in time, or in space, or of a kind or 
shape. Rhythm leads to a comforting sense when the pattern is recognized.

• Progression

Any kind of progressive or regressive change that may be predictable or understood more 
clearly in hindsight, again, in time, space, color, etc. Progression is experiencing change.

Level Design Principles
The following are specific principles meant to help design that deals with space that people or 
characters inhabit, and design that deals with dynamic change in a play environment. As you work on 
your level designs, notice when these principles could help, try them out, and refer to this list when you 
feel something might be wrong or missing. Design is a practice, and we grow as a result. Have fun!
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• Work from large to small

This encourages the designer to begin with the larger ideas, the larger pieces, the immovable 
elements of the design first, and fill in smaller and smaller elements around it. Going the other 
way around often causes time-consuming issues that require reworking the design.

• A sketch on paper with your finger as the player saves time

Speaking of saving time, Level Design is a great place to practice rapid prototyping. A prototype 
is a test, where you look for results to evaluate and improve the design. A rapid prototype 
simply means only do the work necessary to do the test and get an answer to the most 
important question you're facing. Creatively, you can make a test and get an answer by stopping
yourself from doing a lot of work, and asking, “What is a simpler way to see if this idea works 
better or not?”. The classic example is sketching your level layout on paper; even just using lines 
for hallways, boxes for rooms, at first. And, then using your finger to 'walk' through the level and
imagine how this will be for the player. See something that needs to change? That's very, very 
quick with this format, as compared to building the level first to test the rough layout.

• The frame of the view port is the Level Design canvas

This is a reminder that while the Level Designer is often concerned with the entire level, the 
player is usually only aware of one small part of the level at a time: the frame. You help yourself 
by drawing a box that represents the size of the frame on your level design sketch, because the 
trap you're avoiding is assuming the player knows things they've never seen that are off screen.

• The architecture changes as the player moves through the level

Continuing that thought of the frame, consider this subtle, but important, fact about the 
perspective of the player. As a player moves through the level, and their view of this level from 
where they are changes, their perception of the level shape, distances between things, elements
that come into view or go off screen, makes the level appear to change as if it's moving. Of 
course, the level layout is static, but it's this dynamic view that the player provides, along with 
other level dynamics you craft in your design, that the player will experience as change. Imagine 
you've been walking down a long narrow, very tight, corridor, and as you continue, it opens up 
wider, and wider until it becomes a large cavern where the walls are no longer in view. This is a 
static layout that the player has experienced changing from tight to open.

• To find balance, try extremes first

You might be deciding on a detail setting on a tool, or your might be trying to find a balance in 
the amount of swords versus enemies in combat, or your might be stuck trying to decide how 
big a room should be. Whatever the balance issue is, one method of moving forward, to test and
find your way through evaluation, is to intentionally overdue it to one extreme, and then the 
other. Not sure if it should be four or five skeletons in this room? Try 15 and see how bad it 
really is, then try 12, then 8, and see if it's becoming clearer where the upper amount is. Then, 
go for one, then 3, and see if you can find the lower limit. Somewhere between them is the right
balance, so try that when you can.
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Cheat Codes
Did you know that cheat codes were made for the design process? During development, game 
designers and level designers would need to test, and getting all the way to a boss level to test their 
attack pattern, for example, takes time away from making the game better. Cheat codes were made to 
get designers past the normal player challenges so they could interact with the particular part they 
needed to work on.

Pixel Dungeon Dojo gives you cheat codes that work with keyboard or gamepad, so that you have these
available to test with, and along the way you'll notice how helpful it is to use these cheats during your 
level design practice.

Pixel Dungeon Dojo Cheat Codes
These cheat codes are available if you begin a game from the Dojo Menu scene.

You may configure your dungeon to prevent cheat codes from being used. In the “Dojo Level Setup” 
object folder on your entry level of the dungeon, configure the “Dojo Level Tester” tool to “Prevent 
Cheats”. The entire dungeon will then be configured to deny the player from entering cheat codes.

Extra Health

Player avatar is awarded one level of health.

Keyboard: “imhurt” Gamepad: dPadUp, dPadUp, dPadDown, dPadUp, A button, A button

Extra Sword

Player avatar is awarded a vorpal (magic) sword.

Keyboard: “ifight” Gamepad: dPadLeft, dPadRight, dPadLeft, dPadRight, A button, B button

Open Doors

All doors in the level are opened.

Keyboard: “sesame” Gamepad: dPadUp, dPadDown, dPadLeft, dPadRight, X button, Y button

Remove Enemies

All enemies in the level disappear.

Keyboard: “thanos” Gamepad: A button, L Shoulder, R Shoulder, dPadLeft, dPadRight, A button

Skip Level

The player avatar switches to the next level in the current dungeon.

Keyboard: “moveon” Gamepad: dPadRight, dPadRight, dPadRight, X button, Y button, dPadRight
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Making Custom Level Elements
Pixel Dungeon Dojo is designed to make everything available to you immediately. However, if you have 
the patience, you can extend your level designs to include your own artwork, animation or code!

Pixel Art
Try making a decoration for your dungeon level, like spider webs, a crack in the stone, a puddle of 
greenish water or anything you think would make a simple wall, corner or floor look varied in your level.

The standard used in Pixel Dungeon Dojo is a 64x64 image. These are imported as Sprites, with “No 
Filter”, to prevent blending and keep the appearance of pixel art. Any drawing program can make a .png 
file that includes an alpha channel, so clear pixels are also part of your sprite image. A free program 
called GIMP is open source and able to perform things like making separate layers of your image.

Did you know that all game art is square, and that the dimensions are always a power of 8? The reasons 
are technical, but the summary is that this makes the game build smaller.

Tip: Pixel art may seem difficult and time consuming to make individual pixels appear to blend 
from one color to another. Try this method: start with an image that is not a power of 8, but 
larger, like 100x100. Draw your artwork, then before exporting it, copy it and resize the image to
64x64. Suddenly, all that difficult blending is done automatically.

As a test, draw something with a rough outline in black on one layer named “Line”, use a separate layer
behind to “Fill” with a solid color, another layer on top of the fill to add a darker color of “Tone”, and a 
last layer to add a lighter color of that fill we could call “Highlight”.

If you put the line layer on top, with highlight below, then tone and last fill, you can export this as a .png
file and import to Unity using “Assets” → “Import New Asset...”, and select your .png file. (almost any 
image file type will do, but .png files are a standard)

With this asset in your project, you can select it and configure the Import Settings for it in the Inspector 
panel. You can refer to other Pixel Dungeon Dojo sprites as a guide, but in short: “Texture Type” is 
“Sprite (2D and UI)”, the “Sprite Mode” is “Single”, “Pixels Per Unit” is 64, and “Filter Mode” is “Point 
(No Filter)”.

Any changes and revisions are easy if you just go back to your paint application, now that you've seen 
what it looks like in Unity. When you're ready for a new version, you can delete the old one in Unity and 
re-do the “Import New Asset...” process. Even if deleted, Unity will keep all the connections this image 
had with other assets in the project.

Animation
If you've tried your hand at making static pixel art, and you're ready for a challenge, try animation with 
the same paint program. You can use separate layers for individual frames of animation. To start, keep 
it simple, and keep it short; like 3 or 4 frames. (this is known as “limited animation”, and if timed to 
show the frame for around 0.25 seconds, it looks like other Pixel Dungeon Dojo elements)
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Like the pixel art process described above, you can end up with animation frames that have fill, tone, 
highlight and line layers. Again, to keep it simple, you might first just try a single fill layer for each frame.
Later, you can add layers for line, etc.

Tip: When using layers to make animation, consider that the common opacity setting on a layer 
can help you see what the previous layer looked like, as you draw the current one. This faded 
image can help you keep the next frame appearing to move smoothly. You can also turn layers 
on and off to peek at a layer as you work, to check on how they appear when animating.

Animation can be a time-consuming process, but the results are impressive to your players, and you will
learn a lot. If you're feeling brave, try making visual effects like a torch flame or dripping water. If you're 
ready for a real challenge, try a limited animation character run that can loop.

Level Dynamics
Ever wonder how things like doors, switches or wall shooters work? In short, it's code. And you can start 
to use these custom art elements and animations in level dynamics of your own.

Imagine you've made a gate animation that can appear to open. This can work exactly like the door 
element Pixel Dungeon Dojo already gives you, it just looks different. Switching out the frames in a door
you've placed in your level is easy, once you have the frames of your gate animation in the project. 
Suddenly, your custom pixel animation is part of the level dynamics.

To go further with it, and make something that works with Pixel Dungeon Dojo is not as hard as you 
might think. Consider that a Dynamic Activator tool is made to activate game objects. If your custom 
code is simply turned on, and does cool stuff, like enable a Deco Animator tool, or play a sound, you can 
see this work with existing Pixel Dungeon Dojo tools.

Going Even Further
While Pixel Dungeon Dojo is not designed to be used by those who code, those who code can figure out
very creative ways to extend Pixel Dungeon Dojo. Start by reviewing the tool set provided, and studying
the properties and terms used in tool tips and this documentation. What you have is a framework, and 
beyond switching out pixel art frames or sounds, you have the ability to use these tools alongside your 
own custom characters, combat systems or menus.

If you do extend Pixel Dungeon Dojo for your own personal experimentation, that is welcome and fine. 
However, Pixel Dungeon Dojo is not available to be released for commercial purposes in any form; 
please see the license agreement details in the readme file for more.

Pixel Dungeon Dojo is designed for cozy level design practice, and the hope is that you have fun with it.
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Sharing Your Level Designs
Above all, Pixel Dungeon Dojo was made to give you the ability to create and share your level designs 
with friends and family. Whether you give these to someone who has never played this kind of game 
before, or they've professed to be a professional gamer, you are encouraged to share these levels you 
make, and let them see what you can do.

Tip: Always take the opportunity to gather feedback from players. The very best way to do this is
to carefully, and silently, observe their gameplay without interference. You learn a lot about how
players behave when you do this. The information you get will absolutely help you make better 
level designs.

Share the Game
The easiest way to share is to build the game. With the one-button solution provided in the Unity 
editor, “Dojo Tools” → “Configure Player Settings”, you're ready to build the game.

Go to “File” → “Build Profiles” and confirm all the levels you want to share are listed in order in the 
“Scenes List”; which is found on the top right of this pop-up window. If everything is there, you've 
probably already been play testing with it anyway, but you're just making sure it's ready to build.

Click “Build”, and select a location to put this game, perhaps on your Desktop. You'll need a folder to put
it in, and you might just name it, “My Dungeon Levels”. Once selected, the game should build quickly.

That's it. If you're at that location on your computer, open that folder to find the Pixel Dungeon Dojo 
application. It's recommended you make a shortcut for this application to make access easier.

The full game is going to be over 120MB, so you may want to physically share it on a portable drive. All 
they need to do is copy that folder, and double-click to play. You just made a game in Unity!

Share the Levels
For friends or family who also have purchased a copy of Pixel Dungeon Dojo, you may be able to do 
something even better. Sharing levels between friends is one of the best ways to learn level design, and 
it's wildly fun to challenge each other in your practice.

In your Project panel, select individual levels, or the single dungeon folder you want to share. Then, 
right-click and select, “Export As Asset Package...”. By default, Unity wants to include everything but this 
is unnecessary, so un-check both check boxes at the bottom of this pop-up window. Un-check, “Include 
dependencies”, and un-check, “Include all scripts”.

Name your Unity package file and place it somewhere you can find, like the Desktop. It takes no time 
and the resulting file is so small you can easily attach it to an email. Your friend need only download it, 
and in Unity, go to, “Assets” → “Import Package” → “Custom Package...”, to load your levels. Easy!

Tip: Play is an important part of learning and growth. To create is an even higher form of human 
progression. To share might be the most valuable act we can do. Please enjoy with friends.
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